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ABSTRACT 

Size at maturity, reproductive cycle and fecundity of the southern California brown box 

crab, Lopholithodes foraminatus, and implications for developing a new targeted fishery  

  

By 

Ashley Marie Stroud 

 

 

The brown box crab, Lopholithodes foraminatus, is a deepwater crab that is found along the 

eastern Pacific Coast. Historically, landings in California have been low for this species, but 

an increase in fishing pressure prompted the state to designate it as an emerging fishery and 

implement an experimental fishery program for it. With no known biological studies on 

brown box crab in California, gathering essential fisheries information to evaluate the 

feasibility of a targeted fishery is necessary. We investigated the reproductive capacity of 

the brown box crab in southern California. From 2018 – 2021 brown box crabs were 

collected monthly from fishermen.  Size at sexual maturity was determined by 

presence/absence of mature gonads (physiological), relative growth of the chela for males 

and abdomen width for females (morphometric), and presence/absence of eggs on females 

(functional).  We found that females reach physiological maturity at a carapace width 

between 50.8 mm and 71.7 mm, and males between 43.3 mm and 66.3 mm. Morphometric 

maturity analysis showed a clear inflection point of abdomen width between immature and 

mature females. Females were 50% functionally mature at 75 mm carapace width. 

Morphometric and functional maturity was not detected for males, albeit samples of small 
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male crabs were extremely limited thus warranting further study. Females followed a 

biennial reproduction pattern, mating in the fall followed by an 18-month brooding period 

with hatching the following spring. Fecundity was positively related to size and ranged from 

8,352 and 62,181 eggs per female for crabs measuring 67.8 to 130.5 mm carapace width, 

respectively. These findings provide biological information that can inform the evaluation of 

a fishery for the brown box crab, including potential management strategies and models for 

assessing stock condition.  
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INTRODUCTION 

 

In recent years, fishermen have expanded fishing effort for the brown box crab, 

Lopholithodes foraminatus, in southern California to diversify their businesses and take 

advantage of new marketing opportunities. Commercial fishing for the brown box crab is 

not new, it has been commercially landed throughout its distribution along the eastern 

Pacific Coast of North America for decades.  Historically, coastwide landings have been 

small and incidental to other fisheries. Spikes in brown box crab landings, while rare, 

typically resulted when effort shifted towards deeper fishing grounds in search of target 

species, as occurred during the 1983 El Niño in Oregon (Kato., 1992). A similar dramatic 

increase in California landings came at a time when rock crab landings were down (CDFW, 

2020), in part due to the warm water blob and domoic acid events of 2015 and 2016. 

California brown box crab landings increased from 13,000 pounds in 2016 to nearly 70,000 

pounds in 2017; a fivefold increase (Fig. 1). During this time, the price per pound reached a 

high of seven dollars as new markets were developed for this species. The newly developed 

markets undoubtedly were fueled by increased direct to consumer marketing efforts and the 

local food movement. 

The new market demand and increased landings of the brown box crab, however, 

raised some concerns. A fishery for this species was not designated and thus only incidental, 

not targeted take, was permitted. To address this issue, in 2018, California Department of 

Fish and Wildlife (CDFW) designated the brown box crab as an emerging fishery and 

limited incidental take to 25 pounds per day (Coates, 2018).  Then, in 2019, CDFW 

implemented an experimental fishery program (EFP) for the brown box crab (Coates, 2018). 
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The experimental program provides four years to evaluate and determine whether a 

commercial fishery is feasible.  Making this determination requires having the necessary 

information to evaluate the sustainability of the resource. This includes, but is not limited to, 

biomass estimates and sustainable yield, basic biology, and reproduction.  

To help inform this evaluation, we examined reproductive capacity of the southern 

California brown box crab. Although several studies have reported on distribution and catch 

rates (Colomy, 1989; ODFW, 1997; Zhang, 2001), there have been very few studies of the 

biology of L. foraminatus. These studies were conducted in Oregon and British Columbia 

and reported limited information on size at maturity and fecundity (McCrae and Hoover, 

1997; Goddard, 1997; Zhang, 2001). Most recently, Duguid and Page (2011), investigated 

the egg development and seasonality of brown box crab in British Columbia. To expand on 

the limited information, we conducted a study of southern California brown box crab 

reproduction with the following objectives: 1) identify size at maturity, 2) assess fecundity 

and 3) determine reproductive cycle, brood duration and seasonality.   

Size at maturity is defined in three ways: physiological maturity, morphometric 

maturity, and functional maturity (Hartnoll, 1969; Pinheiro & Fransozo, 1998). The presence 

of mature gonads where the reproductive organs are producing gametes, taken to indicate 

physiological maturity, alone does not infer a crab is ready to mate (Waiho, 2017). 

Morphometric maturity is the development of secondary sexual characteristics that enable an 

animal to be physically capable to mate (Hartnoll, 1974, 1978). In many species of Anomura 

and Brachyura, this is denoted by an increase in abdominal flap width in females and a 

change in claw characteristics in males (length, height, gape, etc.) (Jewett et al., 1985; 

Haefner, 1990; Culver, 1991; Alunno-Bruscia, 1998). A successful mating event (functional 
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maturity), while often harder to determine in males (e.g. mating marks) than females 

(presence of eggs), is the most conclusive sign of sexual maturity (Boolootian et al., 1959; 

Butler, 1960). Taken together the three parameters present a clear picture of size at maturity.  

Determining reproductive capacity includes assessments of fecundity, brood duration 

and mortality, and reproductive seasonality. Fecundity, the number of eggs per brood, varies 

among species, as well as within species (Haynes, 1968; Hartnoll, 1985; Otto, 1990). In 

general, fecundity increases with increasing size (Otto, 1990; Shields, 1991). In addition to 

size, regional difference in environmental conditions, such as water temperature, can 

influence brooding time and seasonality (Wear, 1974; Shields, 1991). Duguid & Page (2011) 

found that brown box crab in British Columbia underwent a 12-month diapause, with an ~18 

month overall brooding period and biannual reproduction. Whether California brown box 

crab have a similar reproductive cycle is unknown. Brood mortality, particularly due to egg 

predators, has impacted egg production for other lithodid crab fisheries (Kuris et al. 1991; 

Kuris & Wickham, 1997). This has not been investigated for L. foraminatus. Together, these 

reproductive parameters contribute to estimates of annual egg production for a population. 

Our findings provide information on the reproductive capacity of brown box crab 

needed for evaluating the feasibility of a targeted fishery for this species. Determining at 

what size brown box crabs mature, how many eggs they produce, and when they reproduce, 

is critical for determining the potential sustainability of the population in the face of fishing 

pressure. Study results will inform discussions about potential management options, such as 

size limits, quotas and seasonal closures, and may be used to develop models (e.g., eggs per 

recruit, spawning potential ratios) for assessing stock condition.  
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MATERIALS AND METHODS 

Sampling and Measurements 

Crab samples were obtained from and in collaboration with commercial fishermen 

participating in the brown box crab EFP. Samples were collected from the Southern 

California Bight, south of Point Conception and north of the Mexican border, including both 

island and coastal mainland areas at depths ranging from 120 to 245 meters. Data were 

collected over the course of 3 years (March 10, 2018 – August 31, 2021), excluding a five-

month period (March 2020 – July 2020) impacted by research travel restrictions associated 

with the COVID-19 pandemic. Each fisherman provided a monthly sample of 15 males and 

15 females as weather permitted (Coates, 2018). Monthly samples were supplemented with 

samples of small crabs (<75 mm CW) and molting crabs as available. Additional crabs were 

also provided by the CDFW. Sample crabs were caught using commercial lobster traps (5 x 

10 cm mesh) and custom research or prawn traps – traps with smaller mesh size (2.5 x 2.5 

cm mesh) and closed or no escape ports. The research and prawn traps (referred to as 

experimental traps) were designed to collect a wider size range of crabs that were 

representative of the brown box crab population as compared to crabs captured and retained 

in the commercial traps. 

Size at Maturity 

Carapace width (the widest point not including spines, CW), abdominal width (at the 

suture line near the widest part), left and right propodus length (posterior surface from tip to 

joint), and left and right propodus height (posterior surface from joint to base) were 

measured to investigate morphometric maturity. Measurements were recorded using a digital 



 
 

5 
 

caliper (0.01 mm). Although maximum carapace width (including spines) is used for the 

fishery, CW is used in this study to avoid the inherent issues caused by worn and damaged 

spines. Additional measurements were taken and used for comparisons with other studies as 

well as fisheries data. Conversion equations are provided in Appendix A.  

For determining morphometric and functional maturity, female crabs were 

categorized as mature when eggs or a mat of remnant brood setae, filaments to which eggs 

were attached and remain with empty egg cases, also referred to as “moss” per Zhang et al. 

(1999), were present. When such was not the case, the crab was dissected and the gonads 

were examined. Those with colored (yellow, orange, or red) gonads were categorized as 

mature. Translucent or white gonads were categorized as immature. For males whose vasa 

deferentia were not obviously white and filled, gonad tissue was removed and examined 

microscopically at 100x magnification to determine presence/absence of spermatophores, 

and further confirmed by pressing on the gonopore to see if sperm was released. 

Egg Development 

Egg development of captive brooding females was assessed from September 2019 

through March 2020 at which time research restrictions associated with the COVID-19 

pandemic precluded further observations. Cohorts of eleven crabs were held in chilled (8 - 

10° C) filtered seawater tanks at UC Santa Barbara and Scripps Institution of Oceanography, 

UC San Diego. Each individual was assigned a unique ID by affixing vinyl tags to their 

carapace with ethyl cyanoacrylate gel (bSi Insta-Cure). Crabs were fed a variety of food, 

including mussels, squid, shrimp, scallop, brittle star and an occasional fish carcass every 7 

to 10 days. Samples of approximately 30 eggs or greater were retrieved from each crab by 
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separating two of their limbs and inserting forceps under the abdominal flap. [Retrieving 

eggs by pulling back the abdominal flap was more difficult and lead to damage of the flap.]  

Because Duguid and Page (2011) reported a lengthy diapause stage (up to 12 months of no 

development), eggs were sampled once a month until egg development was initiated and 

then twice a month when eggs were developing. Eggs were observed through a 100x 

magnified lens on a dissecting microscope, development stage determined and recorded 

based off Duguid and Page (2011) and then further grouped into six categories for analyses 

(Table 1). 

Egg stage observations were also recorded for all monthly samples to assess 

reproductive status in nature.  Observations were made visually (rather than using a 

microscope) to mimic field techniques and included four categories: bright orange 

(diapause), dark orange/eye spot (developing), moss (hatched), and empty (absence of eggs 

or moss, clean pleopods).  

Fecundity 

To assess fecundity, crabs were measured as described above and abdominal flaps 

containing full clutches of undeveloped eggs (no eyespots visible by eye) were removed and 

frozen for processing at a later date. Full clutches were defined as egg masses that extended 

close to, or at the edge of abdominal flap. Seven small clutches were also assessed for 

reference. Upon processing, the abdominal flap with the intact clutch was defrosted, the un-

eyed diapause stage was confirmed via microscopic (100x) examination. Pleopods were then 

detached, and eggs were removed from each pleopod by gently scraping the setae with a 

spatula in a petri dish of shallow seawater and subsequently separating clusters with forceps. 
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In preparation for manual and digital counts of the eggs, the eggs were spread in a single 

layer covering 75% of a petri dish avoiding the edges. Multiple dishes were used as needed 

based on the amount of eggs removed per pleopod. Photographs of the separated eggs in the 

petri dishes were taken using a digital camera (Olympus stylus) magnified to 3.0x and 

mounted on a frame with a sheet of blue paper and tracing light underneath, methods 

modified from Bohenek 2017. Counts were then made from the photographs using ImageJ 

software v. 1.52q (https://imagej.nih.gov/ij/) following a validation period when manual and 

digital counts were compared for 45 petri dishes totaling 23,000 eggs. Because the manual 

and digital counts were found to be nearly identical – averaging 1.08 percent error (median, 

0.29%) – only digital counts (Appendix B) were done for this analysis (n= 100). A 

relationship was found between the number of eggs on the third pleopod and total fecundity 

leading to the development of a calibration equation for fecundity estimations: total number 

of eggs = (number of eggs on pleopod three) * 4.255. For 13 crabs, only eggs attached to 

pleopod 3 were counted and the equation was applied to calculate total number of eggs.  

Analysis 

Statistical analyses were performed using R software (R Core Team, 2020) and 

Microsoft Excel. The significance level used for all analyses was p = 0.05. Data was log 

transformed and analysis of covariance (ANCOVA) was used to analyze morphometric 

maturity and the influence of location on fecundity. Morphometric relationships and the 

relationship between size (CW) and fecundity were determined using linear regression. We 

also explored a quadratic fit for fecundity, with further data needed on both extremes to 

resolve the relationship. The size at 50% maturity was calculated and illustrated with the 

https://imagej.nih.gov/ij/
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Aquatic Life History Package in R (Smart, 2016). Due to limitations on receiving a full-size 

range of crabs, the effect of location on size at maturity could not be analyzed. 

 

RESULTS 

Size at Maturity 

  In total, 1637 brown box crabs from the Southern California Bight were examined 

with 767 females and 870 males. Females ranged from 45.3 mm to 134.0 mm CW. Males 

ranged from 43.7 to 188.5 mm CW.  

Physiological 

Thirty-three females were classified as immature. The largest immature female was 

71.7 mm CW, while the smallest female with mature gonads was 50.8 mm CW, and the 

smallest ovigerous female was 67.8 mm CW.  

We identified only four immature males with measurements of 43.7, 47.0, 60.5, and 

63.6 mm CW. The smallest mature male was 47.3 mm CW, with all males at or above 66.3 

mm CW physiologically mature.  

Morphometric  

A significant allometric shift in abdomen width was identified for immature and 

mature females (Fig. 2) (F (1, 728) = 47.685, p <.001). Immature and mature crabs 

overlapped in size between 50 mm and 72 mm CW, with crabs below 50 mm CW immature 

and those above 72 mm CW mature. 
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No allometric shift denoting maturity was identified for male brown box crabs. The 

relationships between size (CW) and male propodus length and height were similar for 

immature and mature crabs (Figs. 3, 4).  

Functional 

Females were 50% and 95% functionally mature (i.e. presence of eggs or moss) at 

75.0 ± 1.01 mm CW and 88.9 ± 1.26 mm CW respectively (Fig. 5). Functional maturity 

could not be estimated for males due to the lack of immature specimens. 

Reproductive Seasonality and Egg Development 

Mating events occurred in the fall as evident from observations of grasping pairs, 

ovigerous females with newly extruded (bright orange) eggs, spent ovaries and soft shells. 

The bulk of the mating occurred between September and October. There was a shift in the 

ratio of moss females and egg bearing females in September to nearly all females bearing 

eggs in October (Fig. 6).  

 Egg bearing females occurred year-round, but were most prevalent (> 90% of 

samples) from October through March (Fig. 6). Females with eggs in diapause occurred 

year-round, and those with developing eggs were observed from October through May with 

fully hatched broods (moss) evident from June through September. 

For crabs held in the laboratory, eggs began developing in October. Eggs adjacent to 

one another developed at differing rates. Asynchronous development and hatching were not 

localized to areas within a clutch but rather dispersed throughout. Broods developed over an 
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approximately six to seven-month period, with the first signs of hatching observed in 

February (Fig. 7).  

Fecundity 

Fecundity ranged from 8,352 to 62,181 eggs per clutch for brown box crabs (n=93) 

ranging in size from 67.8 to 130.5 mm CW (Fig. 8). The slopes of the size-fecundity 

relationship did not significantly differ between locations (F (1, 96) = 0.0185, p > 0.05). 

There was a positive relationship between clutch size and carapace width that was generally 

linear (R2 = 0.83), although a similar quadratic fit was also detected (Fig. 9, R2 = 0.81). 

There was high variation in fecundity within size classes (Table 2). Fecundity of abnormal 

small broods (n=7) ranged from 7,813 to 40,787 for crabs 94.4 to 125.5 mm CW (Fig. 8).  

 

DISCUSSION 

Our results provide essential fishery information to evaluate the potential of a 

California fishery for the brown box crab, Lopholithodes foraminatus. Female size at 

maturity was smaller in southern California compared to studies further north. In British 

Columbia, 50% functional maturity was reported at 80 mm CL, and 95% at 90 mm, as 

compared to 68 mm CL (75 mm CW) and 79 mm CL (89 mm CW), respectively, in our 

study. The smallest gravid female reported in British Columbia was between 65 and 75 mm 

CL (specific size not cited) (Zhang, 2001) and in Oregon was 68 mm CL, whereas in our 

study it was 62.3 CL (67.8 CW). These comparisons follow the general pattern of size at 

maturity decreasing with lower latitude (Hines, 1989; Dugan et al., 1991), a pattern also 

found in North Pacific populations of some king crab species (Olsen et al., 2018). However, 
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obtaining small immature crabs required fishing with smaller mesh traps (2.5” x 2.5” cm) 

and in deeper waters (~250 m) than where legal-sized crabs were fished, which may have 

influenced the size at maturity we identified as compared to others.  

We report the first evidence for female morphometric maturity in the brown box 

crab. Previously, coverage of the coxa by the abdominal flap and the presence of setae on 

the pleopods has been used to distinguish juvenile from adult female king crab (Donaldson 

& Byersdorfer, 2005). Our examination of these features did not coincide with maturation as 

determined by observation of gonad status. Although the change in female abdomen width 

relative to carapace width was not readily evident as it is with Brachyuran crabs, a clear 

relative width inflection between the two groups was consistent with assigned 

physiologically based categories of mature and immature female box crabs.  Since the 

morphometric differences are subtle, presence of eggs will still be the most readily available 

technique to identify mature female crabs in the field, despite the overlap in size for juvenile 

and adult female crabs. 

Male size at maturity could only be recognized physiologically, not 

morphometrically or functionally. In agreement with the 1997 Oregon study, no inflection 

point was detected when evaluating the relationship between crab size and the two right 

(dominant) claw morphology parameters (PL, PH) for immature and mature male crabs. 

Additionally, we examined the male genital pore for setae abrasion to determine functional 

maturity as suggested by Goddard (1997), but it was not a useful indicator. Setae were 

observed over a wide range of sizes with no distinguishable differences of wear. The large 

size range of physiologically mature males (47 mm – 189 mm CW) and small sample size of 
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immature males (n=4), necessitates further investigations of morphometric indicators and 

functional maturity to determine the size at which male crabs can successfully mate.  

Our study provides the most comprehensive fecundity analysis of L. foraminatus. 

Through it, we documented the highest reported egg count (62,000 eggs) for this species, 

and demonstrated the similarity in fecundity for crabs throughout the Southern California 

Bight. As expected, the number of eggs increased with increasing size, with no indication of 

senescence as seen with other species of crabs (Swiney et al., 2012; Danielsen et al., 2019). 

Oregon’s fecundity estimates (n=4) were similar to ours for large (~120mm CW) crabs, 

48,100 eggs and 51,200 eggs respectively. However, their estimates were a bit higher for 

small (~75 mm CW) crabs, 20,100 and 16,000 eggs respectively. Given variation within a 

size class, fecundity-size relationships may be similar for crabs from these regions, but 

further fecundity studies in Oregon are required. With this, we conclude that the resulting 

size/fecundity relationship can be used to evaluate reproductive capacity of box crabs 

throughout southern California, and potentially elsewhere.  

Brood mortality can have a significant effect on reproductive output (Kuris, 1991). 

In particular, the red king crab has experienced high brood mortality, losing the majority of 

broods due to a nemertean egg predator (Shields et al., 1990; Kuris et al., 1991). Even 

though we did not directly study brood mortality, during our fecundity assessments we did 

not observe empty egg cases, nor egg predators, even for broods that were further along in 

diapause (~8-10 months brooding time) and presumably had longer exposure time to 

potential mortality sources. The egg counts of these older broods were similar to those that 

were fresh broods, suggesting negligible brood mortality. On occasion we observed small 

clutches or barren females. It is unclear if this was the result of brood mortality or a less 
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successful mating event. Although we encountered this rarely, suggesting it likely has little 

impact on reproductive capacity of the population, we recommend future monitoring of 

brood size and, if warranted, potential factors influencing it. 

Our field and captive observations of the Southern California brown box crab 

support an ~18-month biennial reproductive cycle (Duguid & Page, 2011) (Fig. 10). The 

majority of time (~12 months) the eggs are in diapause, therefore females with eggs can be 

found year around. During winter and spring, eggs will be either in diapause or developing 

and hatching depending on when the female mated. The duration of the reproductive cycle 

in California matches that of British Columbia (Duguid & Page, 2011). Studies have shown 

that temperature can affect duration of embryonic development (Stevens et al., 2008). The 

similarity in the duration of the reproductive cycle between California and British Columbia 

may be partially explained by the minimal difference in thermal temperatures of deepwater 

habitat in the two locations (Culver et al., unpubl.data; Duguid & Page; 2011), far less a 

difference than what occurs in shallow waters. While the duration of the cycle is similar, the 

timing differs. In British Columbia, mating and egg development commence in late summer, 

whereas in California these events take place largely in the fall. Investigating other 

environmental parameters (e.g., ocean productivity, day length, swings in temperature; 

REFs) that differ between the two locations and can influence timing of mating and 

reproduction may reveal why the cycles commence at different times.  

Our findings can inform the evaluation of management strategies for a fishery 

targeting L. foraminatus. Currently, the experimental fishery is managed primarily through 

the use of a size limit and a quota. The minimum legal size for brown box crab is set at 146 

mm CW including spines (i.e., maximum carapace width) which was based largely on 
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market demand. As female brown box crab typically are smaller than the legal size, they are 

not currently being harvested and likely won’t be considered in the future. As a result, they 

are able to contribute reproductively to the population throughout their lives. For males, our 

current research supports this size limit as they mature at a much smaller size allowing them 

to contribute reproductively prior to harvest. Further, our preliminary analyses of growth 

rates (Culver et al., unpubl. data), albeit limited, suggest they may reproduce for many years 

prior to harvest. Molt increments decreased from around 16% for males between 64 and 100 

mm CW to less than half that (~7%) for males above 120 mm CW. Additionally, results 

from our monthly samples indicated that males likely molt only once per year. Based on this 

slow growth rate, if functional maturity is close to physiological maturity, a 64 mm CW 

male brown box crab would have about six years to contribute to the population before 

reaching legal size.  

While the catch size limit seems appropriate, size selective fisheries using a 

minimum size can have drawbacks (Conover & Munch, 2002; Fenberg & Roy, 2008; 

Varisco et al., 2019). By selecting for large males, there is a long-term potential to drive the 

population towards a smaller size at maturity and slow growing individuals, evolving 

towards small body size and lower fecundity. Some fisheries have implemented a slot limit 

(Ahrens et al., 2019; Pellowe & Leslie, 2020), restricting harvest to intermediate sizes, a 

measure to continue to allow reproduction prior to harvest while also protecting the genetics 

and reproductive potential of the larger individuals. Future studies on growth rates and 

mating success would help inform the determination of the most appropriate size limits for a 

sustainable fishery.   
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Another strategy that might be considered is seasonal closure. Many fisheries use 

seasonal closures to protect stocks when crabs are molting and/or reproducing (mating, eggs 

hatching). Because female brown box crabs are not currently harvested, and not likely to be 

harvested due to their small size, protection of hatching season is not needed. Instead, 

closing the fishery during the molting and mating season might be considered. Because 

molting and mating are basically synchronous and quite seasonal, a short-term closure 

during September and October would protect the majority of the mating/molting population 

should additional measures be required. The specific timing and duration of the closure 

would need to be periodically reassessed in light of ongoing environmental changes.  

Lastly, if California brown box crabs do indeed have limited movement as reported 

(Colomy, 1989; Kato, 1992), rotational zone management could be an option. Density can 

play a large role in reproductive potential of marine organisms. Populations with a low 

density of reproductive males can result in lower reproductive success due to limited sperm 

resulting from high mating frequency, female waiting time for a mate or the inability to find 

a mate (Powell et al., 1974; Kendall et al., 2001; Sato et al., 2005). Use of rotating area 

closures could help to slow reductions of localized densities as seen with the sea cucumber 

fishery (Plagányi et al. 2015). Ongoing investigations of brown box crab movement by 

resource managers, together with investigations of density-dependent reproductive success 

(e.g. tracking number of barren mature females) is needed to better understand the potential 

utility of this management strategy for the brown box crab fishery. 

Although the EFP provided a unique opportunity to collect information prior to 

implementing a large-scale brown box crab fishery, research was limited for several 

reasons. In particular, due to the structure of the EFP, the limited number, varying 
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experience, and varying desire to partake in scientific studies of participating fishermen 

created inconsistencies in the quantity and quality of samples. The regulatory nature of the 

program also resulted in unanticipated constraints that affected collection of research 

samples, especially small crabs caught incidentally in other fisheries. Additionally, the 

COVID-19 pandemic restricted our ability to conduct laboratory work and pick-up samples 

while simultaneously disrupting seafood supply chains, limiting ability of fishermen to 

harvest crabs. Overall, while essential fishery information was gathered, further research is 

needed to inform development of a large-scale commercial fishery for L. foraminatus. 
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Table 1. Comparison of Duguid and Page (2011) egg development images to categories 

used in this study.  

 

Duguid Figure Egg Development Category  

C/D Diapause, no development occurring  

E/F/G Development initiated   

H Eye spots present, >80% yolk 

I Eye spots with ~75% yolk 

- Eye spots with ~50% yolk (not pictured in Duguid figure) 

K Eye spots with ≤ 25% yolk 
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Table 2. Fecundity of southern California brown box crab for 10 mm interval size classes. 

Note, for comparison to other studies, conversions were made to rostrum carapace length. 

Size class of CW (mm) n() Min Max Mean SD 

60.0 - 69.9 1 8,352 8,352 8,352 NA 

70.0 - 79.9 7 12,023 16,492 13,974 1778 

80.0 - 89.9 12 16,318 27,247 20,449 3606 

90.0 - 99.9 33 16,791 41,588 26,966 5260 

100.0 - 109.9 19 24,895 51,587 36,864 7414 

110.0 - 119.9 15 33,694 50,202 42,266 6138 

120.0 - 129.9 4 42,362 51,245 46,918 4178 

130.0 - 139.9 1 62,181 62,181 62,181 NA 
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Figure 1. Statewide fisheries landing data of Lopholithodes foraminatus in California, 1987 

– 2017. San Diego and Santa Barbara included for reference.  
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Figure 2. The relationship between abdomen width and carapace width for female box 

crabs, Lopholithodes foraminatus. Separate allometric equations have been fitted for adults 

(open circle and solid line) and juveniles (closed triangle and dashed line).  

 

 

 

 

 

 

 

 

 

 

 

y = -1.1 + 1.2x ,  R2 = 0.94 

y = -1 + 1.1x ,  R2 = 0.95 
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Figure 3. Relative growth of log carapace width to log propodus length for male 

Lopholithodes foraminatus by maturity group. Separate allometric equations have been 

fitted for adults (open circle and solid line) and juveniles (closed square and dashed line). 

  

y = -1.5 + 1.1 x , R2 =0.94 

y = -0.93 + 0.99 x , R2 =0.99 
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Figure 4. Relative growth of log carapace width to log propodus height for male 

Lopholithodes foraminatus by maturity group. Separate allometric equations have been 

fitted for adults (open circle and solid line) and juveniles (closed square and dashed line). 

  

y = -2.1 + 1.1 x , R2 =0.93 

y = -1.5 + 0.98 x , R2 =0.99 
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Figure 5. A curve fitting the proportion of females classified as mature by carapace width. 

The size at 50% maturity is denoted by the black filled circle.  
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Figure 6. Seasonality of southern California brown box crab egg development.  
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Figure 7. Asynchronous clutch development over time for laboratory held brown box crab. 

*Samples not taken in November.  
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Figure 8. Relationship between log fecundity (F) and carapace width (CW). The straight 

line represents the linear relationship (n=93), F = 0.03 (CW) +7.49 (R2= 0.83, p < 0.001). 

The shaded area indicates the 95% confidence interval. Small clutches (n=7) represented as 

open circles.  
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Figure 9. Quadratic relationship between fecundity and carapace width of the female brown 

box crab. F = -23,707 +306.4x + 2.4x2 (R2 = 0.81, p < 0.001). 
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Figure 10.  Timeline depicting general duration of egg development phases during biannual 

reproduction of the brown box crab. Female A mated and extruded new eggs in October of 

Year 1. Female B mated October the prior year (year 0) to the depicted Year 1.  
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Appendix A  

Conversion Equations  

for Box Crab Measurements 

 

Studies of Lopholithodes foraminatus use a variety of measurements to define crab 

size and associated anatomical attributes. To address this issue and enable comparisons 

across studies, we took additional measurements and developed calibration equations using 

linear regression. Measurements were recorded using a digital caliper (0.01 mm) as 

described and shown in Table 1 and Figure 1.  All measurements were compared to carapace 

width (CW), our standard measurement for this study, with males and females reported 

separately. We used these equations to calculate measurements that enabled comparisons 

across studies for our manuscript. Our equations complement those provided by Zhang et al. 

(1999), which represent female and male crab measurements combined.  

 

Table 1. Definition of measurements for the brown box crab. Number corresponds to 

measurements in Figure 1.  

 

Attribute (abbreviation) Number Measurement 

Carapace length (CL) 1 Rostral teeth to posterior carapace edge 

Orbit length (OL) 2 Right eye orbit to posterior carapace edge 

Mid carapace width (mid CW) 3 Midsection not including spines 

Carapace width (CW) 4 Widest point not including spines 

Max carapace width (max CW): 5 Widest point including spine 

Propodus length (PL) 6 Posterior surface from tip to joint 

Propodus height (PH) 7 Posterior surface from joint to base 

Total body wet weight (wgt)  8 Measured to the nearest 0.5 gram 
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Figure 1. Illustration of brown box crab measurements. Number corresponds to 

measurements defined in Table 1. Drawing adapted from Goddard (1997).  

.  
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Figure 2. The relationship between carapace width and carapace length for female and male 

brown box crabs, Lopholithodes foraminatus 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3. The relationship between carapace width and orbit length for female and male 

brown box crabs, Lopholithodes foraminatus 
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Figure 4. The relationship between carapace width and mid carapace width for female and 

male brown box crabs, Lopholithodes foraminatus 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5. The relationship between carapace width and mid carapace width for female and 

male brown box crabs, Lopholithodes foraminatus 
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Figure 6. The relationship between right propodus length and right propodus height for 

female and male brown box crabs, Lopholithodes foraminatus 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 7. The relationship between left propodus length and left propodus height for female 

and male brown box crabs, Lopholithodes foraminatus  
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Figure 8. The relationship between carapace width and weight (g) for female and male 

brown box crabs, Lopholithodes foraminatus 
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Appendix B 

Egg Separation and imageJ egg count protocols 

Modified from Bohenek 2017 

Citation: Patrick, C., L. Enright, A. Stroud and C. Culver. 2020. 

Software: ImageJ ver 1.8.0 

 

Defrosting the Pleopods 

1. Place the frozen abdominal flap of the crab in a plastic container filled with warm 

water. Do not remove the abdominal flap from the plastic bag.  

a. TIP: Make sure the plastic bag is sealed all the way. Exposing the eggs to 

fresh water can make it difficult to separate the eggs & will lead to more 

breakages.  

2. Allow the abdominal flap to defrost for 5-10 minutes. 

3. Remove the plastic bag from the water and extract the abdominal flap from the bag.  

4. Place the abdominal flap in a petri dish. Using the camera, take a “brood photo” 

before removing any pleopods or eggs. This is a reference photo that may be used at 

a later time 
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Pleopod numbering 

1. Each abdominal flap should have six pleopods. These are appendages within the 

abdominal segment where the eggs are attached.  

2. Pleopod number, as defined in the below picture, is to be recorded along with the 

affiliated egg count. 

 

 

 

 

 

 

 

 

Pleopod Removal 

1. Begin with Pleopod #1 (according to numbering above). Remove in numerical order 

from 1 through 6.  

2. Gently grasp the base of the pleopod close to the abdominal flap with forceps. Be 

careful to not crush any of the eggs. 

3. Pull the pleopod outwards from the abdominal flap. Do not rip the base of the 

pleopod off the abdomen. The pleopod should separate easily from the other 
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pleopods while maintaining all attached eggs and remaining connected to the 

abdominal flap.  

4. Using dissecting scissors, carefully cut the base of the pleopod, separating it from the 

abdominal flap. Perform the cut as close to the base as possible, in an area where 

there are no eggs attached to the pleopod. This ensures that all eggs attached to the 

pleopod remain intact and accounted for. 

5. Occasionally during defrost or pleopod removal, you may notice some eggs that are 

not attached to any pleopod, such as eggs that are loose in the ziploc bag. Be sure to 

COUNT and RECORD the quantity of these loose eggs.  

Note: Often, you cannot finish an entire sample in one day. Samples can be refrozen but be 

sure there is no excess seawater in the ziploc. When eggs are refrozen with excess seawater, 

they more readily break and can be difficult to separate 

 

Separation of Eggs 

1. Place the pleopod into a plastic or glass petri dish. 

2. Add seawater to the petri dish until the bottom of the dish is covered with water, 

filling the dish up to less than halfway with seawater.  

3. Place the petri dish under the dissecting microscope and adjust the lens so that 

sections of the pleopod and the end of a spatula can be seen. 

4. Grip the base of the pleopod with a pair of forceps, and gently scrape the eggs off the 

pleopod using a spatula. Use downward scraping motions, as well as motions parallel 

to the dish, to remove the eggs until all eggs have been separated from the main 
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section of the pleopod. Once this has been completed, remove the eggless pleopod 

stalk from the petri dish.  

5. Zoom in on the eggs so that individual eggs can be clearly visualized, as well as the 

connective tissue between the eggs. Using two forceps, or a spatula and forcep, 

separate the eggs from each other. The latter method is better for separating larger 

clumps of eggs, while the former is better for separating small clumps of 2-3 eggs. 

One pair of forceps can be used to hold the connective pleopod tissue between the 

eggs while the other is used to pull the eggs apart, breaking the connective setae. Be 

careful using the spatula method, as it can result in more broken eggs. All broken 

eggs should be recorded.  

6. Some eggs may be discolored (opaque white or grayish with a red spot in the center). 

These eggs are naturally deceased (often via bacteria). These eggs should not be 

counted in the main count, as they will not become larvae. However, the eggs should 

be separated, photographed and count recorded to help determine mortality.  

Photographing the Eggs 

1. After the eggs have been fully separated, divide the eggs into separate plastic or glass 

petri dishes. The number of petri dishes used will vary by pleopod and crab. Each 

petri dish should only be covered ½ to ⅔ in area by eggs so there is enough spacing 

for eggs to be recognized by ImageJ. 

2. Set up the photography station (see image below). Use a lighted tracing board for the 

base, and place a blue sheet of paper on top to create a contrasting background for 
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Image Analysis 
Camera Setup 

the eggs. Center the photography apparatus on the paper, and screw on the digital 

camera pointing downwards per the stand set-up protocol. 

 

 

 

 

 

 

 

 

 

 

 

3. Place a petri dish on the blue paper so that it is centered in the frame of the camera. 

Adjust the zoom of the camera to 3X so the petri dish fills the frame. Keep the level 

of zoom consistent for all photos.  

4. Add a small amount of seawater to the petri dish so the eggs are slightly floating and 

movable. Use a spatula to move the eggs away from the edge of the dish, and 

separate the eggs from each other to minimize clumping. Eggs should not be 

overlapping and should be spread in the dish as a single layer. 

5. Turn the lights off in the lab to maximize contrast between the eggs and the 

background in the photo. This is important for processing in ImageJ later.  



 
 

45 
 

Example of 

6. Take a photograph using the digital camera. Record the camera photograph number 

and the amount of seawater 

7. Repeat the process using different amounts of seawater to create a photograph with 

as much distinction between the eggs as possible. Levels of seawater (with 

advantages and disadvantages) include: 

a. No seawater (minimizes mobility of eggs, can cause clumping) 

b. Some seawater (lessens mobility of eggs, allows for separation) 

c. Full of seawater (causes mobility of eggs, allows for more separation) 

Note: Avoid individually floating eggs; as they are easily excluded in 

imageJ.  

 

 

 

 

 

ImageJ Analysis (Automated Egg Counting, ImageJ ver 1.8.0)  

 

1. Open ImageJ software and load the Image to analyze from File → Open 

2. If necessary, crop the image by selecting the rectangular selection tool , make a 

selection over the petri dish, and press Ctrl+Shift+X to crop the image. 
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3. Go to Image → Adjust → Color Threshold to select the eggs apart from the 

background. Modify Threshold color from Red to B&W from the drop down box. 

Note that on older versions, the B&W is set to recognize black as objects and white 

as background. As per version 1.8.0, this is reversed, where white is the object and 

black is the background.  

(Note: If the eggs appear black and the background is white, just unclick “dark 

background”) 

 

 

 

 

 

 

4. Adjust the brightness to include darker shades by moving the upper slider to the left 

to capture the darker edges of the eggs. The bottom slider value will vary depending 

on the photo. However, starting at a value of 121 (as pictured below) is a good 

baseline for making adjustments.  
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5. Close the Color Threshold window and go to Image → Type → 8-bit. This will make 

the image black and white. 

6. Go to Process → Noise → Despeckle to make the edges of the eggs cleaner. This can 

be done multiple times as needed to get clean silhouettes of the egg. 

 

 

 

 

 

 

 

 

 

 

7. Go to Process → Binary → Watershed. This causes ImageJ to introduce a 1 pixel 

gap between shapes where the computer’s algorithm thinks edges of objects are 

touching. 
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8. Click Analyze → Analyze Particles. A new window asking for analysis parameters 

will open. Set the size boundary to be 5 to infinity to exclude pixels that are noise. 

On the dropdown box for Show, choose Outlines. Make sure that Display results and 

Summarize are checked, and click OK. 

 

 

 

 

 

 

9. A new window containing the outlines of the counted shapes, and a window 

summarizing the number of objects counted for the image will show. Record the 

results. 
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NOTE: Sometimes the photos taken in the lab are not compatible with ImageJ processing. 

For example, the eggs are too close together or there is not enough contrast. If this happens, 

retake the photo. 

 

Manual Counting of Eggs on ImageJ  

1. Open ImageJ software and load the Image to analyze from File → Open 

2. If necessary, select the rectangular selection tool , make a selection over the 

petri dish, and press Ctrl+Shift+X to crop the image. 

3. Select the Multi-point tool  

4. Click on the eggs to count. 

 




